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1. Introduction

Export is a tool that enables the user to generate from CitiDirect BE statements as electronic data sets in a selected or defined
format. Such a statement may be later imported to a financial and accounting system.

Preparing data export consists of 2 stages:

1. Create a profile
At this stage, the user defines such criteria as time span, accounts and data format.

2. Run
At this stage, the file with the statement is generated and downloaded.

2. Creating an Export Profile

In order to create an export profile, place the cursor on the File Services tab in the top menu, next choose the option Create
Template under Export File Template.

CitiDirect BE®

CaiDwect Services Payments B _1:: "','q_‘""";;" File Services

e DEMO POLAND | 0 failed attempis since Last login 071112018 11:30:19

Export File Template -import File Template Schedule Files and Reports
Wigew Al To SubmetiModmRapair Wi All
To Submadoady/Rapair T ALthiize T SubmadModily/Rapair Dmize Homepage

g Creata Template To Authonize
GDPR - mpotant informabion From 22.07 CitiDirect BE require TLS 1.2 p e g st
Create Scheoule

Impon Transactions

Wezw All Additional Services
Wigw Al To Test Document Services @
My Favorites '*:“ I To Tes ocument Services
To Run To Authorize
| — To Run History To Run
A Co lTD Pyl W To Run Hislory
A Export Custom Fomat
b Now you can add your links as your favorites. igw All s "
"Ju Addd YOUT DT &5 tavorite by Clicking thi S4ar icon L
B - = To Submesoady hew All
Sarve A oup it
oA Create Custom Farmat To Submitiody
w Creale Certificate
Import File Temphate
View All
Payments Pending Action
CHCk here to Customize your shortcuts
Reports Manager =]
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The screen will display the view as shown below.

Although the template has many parameters, only a few are required to be modified.
Begin with entering a Template Name and choosing an Output Format Name.

Home CaliDirect Sarvices Fayments File Services

At DEMO POLAND O Eailed attoempts since Bst bogen 07112018 112018
H ol

File Services » Export Fie Tempiale « Creale Template

Create Template

Expor File Template Details

Template Details
« Template Name J Tempilate Description
S B TS SATVCE % UAKpaLE emat M
Payments - Statement Data _v_: ik

1) Template name
A profile may have any name, provided that it is unique, i.e. when creating several profiles, you must ensure each of them has
a different name.

2) Output format name
In this field, you should define the data format. Click on the Lookup (binoculars) button to begin searching the list of data formats for
export. Next, choose the Output Format name, which you would like to use to build the export profile, e.qg.

B Show Search

Output Format Mame {1 - 25 of 47) Page |1 |of2 b M
Format Mame Format Description

Bal1 BAI A
BAN 1.2 - DEI04 BAIT v1.2 - DEY

BAI vi3- 0105 BAM v1.3- 01005

HAI2 BA2

BALR w12 - DS BALZ v1.2 - DEDY

BALR w13 - 01105 BAIZ v 3 - 0105

COM-Lie BAIR COM-Like BAI2

COM-Like BAIR v1.1 - D206 COM-Like BALZ w1.1 - 0406
E_'n‘!:lal'l'r""-; Flat File j [Eltwﬂm Flat Fise

Citicaniang Flat File w1 1 - D& Citixankang Flat Fite vi. 1 - 06405 et
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3) Date Range Type

Absolute - actual dates are to be chosen from the calendar. This type of dates is useful when you want to download a statement for
a specific period, e.g. previous month. The fields From Day and To Day will change their format into calendar and you need to set the
required date range in them.

Relative - this date range is defined by reference to the export run date. You should select it when you want to use the profile on

a regular basis to generate statements that is not defined by calendar dates, e.q. yesterday, last week. In From Day and To Day

fields specify the number of days to be covered by the statement. For example, if you want to generate, every day, a statement for
yesterday, set '-1"in both fields. If you additionally check the Business Days option when choosing the date range, the program will
skip all holidays while selecting the time span. For example, on Monday the prior day will mean Friday.

Export File Template Details

~ Template Details * = Required Field

( Template Name Template Description
= 1)

+* Business Service (Ouiput Format Name
‘ Payments - Statement Data | ‘SA\Z [y}

~ Template Settings % = Required Field

(® Default Date Range ) Incremental EOD Statement () Incremental Export Indicator

Date Range Type (Calendar Days) Date Type

Relative From Day E ¢ To Day E # Statement Date

[ | Business Days From [12:00:00 AM| @) To [11:59:59 FM | @) [] Activity Only [ ] Wait for All EOD Data
Encoding Set
‘ User Login Language Code Fage |
~ Format Settings % = Required Field
+ Qutput Option + BAI Record Length Indicator BAIl Record Length
| standard Export [v] | varaoie [v] 0
+ BAI Labels
‘ CitiDirect | ] Enhanced BAI Type Code Mapping

Template Parameter

~ In-Session Template Parameters # = Required Field

Security Method

| noNE [v]

~ A dT

4) Download destination

Enter the location and the file name under which the exported statement will be saved. You may use Browse. When downloading
a statement, the system will automatically open the folder that is entered here and suggest you to save the statement under the
given name. If this field is left blank, you will need to select the directory and enter the file name for each download.

5) Template filters

These functions are used to select accounts or groups of accounts. You should select one of the three available Categories: Account

Number, Bank Branch, Currency. Next, click on Add in the Filters Table to see the list of items that can be chosen.

e Use the Account Number category if you wish to select one or more accounts from the list of all accounts that are available to
you.

e Currency is useful when you want, for example, to generate a statement that covers all EUR accounts, but you do not want to
choose them.

* Bank Branch category is only useful for Clients who have accounts with more than one branch of Citi.

ul
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Template Parameter

~ In-Session Template Parameters % = Required Field

Security Method

| noNE [v]

~ Automated Template Parameters

Delivery Option Security Method Certificate Name
\ x| | \ |

Template Filters

~ Account Number | j=f Add

Filter By Account Number Filter By Description
| .

Remove

Account Number (Selected ltems: 0)

O Account Number Description

Remove

> Bank Branch

» Currency
()

Template Filters are not mandatory. If no selection is made after starting the profile, the system will export a file containing
statements to all accounts available to the user that initiated such export.

If the following fields have been filled out, in order to complete template creation, press Submit.

The newly created template is Active and you may use it immediately.

)}
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The template should be visible on the template list in the Export data tab.

Export Data: View All

View All To Run

Show Applied Search Criteria

View Detarls

View All (1 - 50 of 52)

To Run History

Page ElofE B Bl

(Selected ltems: 0)

E} save As 5 Print

(As of 071712018, 12:19) @ &

)A

O Template Name 14 Template Status Output Format Name Created Date/Time Created By Last Modified Date/Time
[1 001 mt940 Active SAP MTO40 04/06/2013 3:46 PM ROGULSK], KAROL
(|:| 123 Active BAI2 07M7/2018 12:19 PM TRZECIAK, NATALIA
[ AAAKar Delete Authorization Required SWIFT MTa40 121172017 1:10 PM ROGULSKI, KAROL
[ Attt Delete Authorization Required SWIFT MT940 12129/2017 12:44 PM ROGULSKI, KAROL
[ crC Active SAP MT940 06/D4/2013 12:08 PM MICHNA, JAKUB
O exp Delete Authorization Required IS0 XML camt 052 001.02 06212017 4:04 P GUTEK, RADOSLAW
[ EXPORT Delete Authorization Required Legacy SWIFT MT940 - EBR 06/21/2017 4:03 PM GUTEK, RADOSLAW
[ INTRA Active TEST PS5 04/19/2018 10:53 AM SZTUDER1, PRZEMYSLAW
[ INTRAZ Active SWIFT MT940 04/19/2018 10:57 AM SZTUDER1, PRZEMYSLAW
[ IntraDay Delete Authorization Required SAP MT940 10/20/2017 413 PM MICHNA, JAKUB
< >

View Details

If, however the template did not show up on the list, this indicates that it requires further authorization by another user. Authorization may be
made by any user who is entitled to create export profiles. A given profile must not be authorized by the person who submitted it.

The Bank may disable the Authorization Required option for export profiles upon demand expressed by phone.

In order to authorize, place the cursor over File Services in the top menu, and next choose the option To Authorize under the section
Export File Template. Select the chosen template and press Authorize.

n as: DEMO POLAND

0 failed attempts since last login 07/17/2018 10:16:21

File Services » Export File Template » To Authorize

Export File Template Pending Actions

B view Al 43 | To SubmitModify/Repair O LY TTReT:

Export File Template: To Authorize

Show Applied Search Criteria

R [ et view e

To Authorize (1 - 34 of 34)

O Template Name 1 a
[ mT240_1

[ MT940_AFRD

[ PATNOSCIWYCHODZACE
[ patnosci wychodzace

ps test
[ Raport z lokat i sweep

s

SAP MT240

SAP MT9407

SAPMTS40 - Incremental St

000

Template Status
Delete Authorization Reguired
Delete Authorization Reguired
Delete Authorization Reguired
Delete Authorization Reguired
Delete Authorization Required
Delete Authorization Required
Delete Authorization Reguired
Delete Authorization Reguired
Delete Authorization Reguired

Delete Authorization Reguired

) e

Output Format Name

SWIFT MT840

SWIFT MT240

SWIFT MTO40

SWIFT MT940

TESTPS2

Raport z transakcji plynnosc
SWIFT MT940

SAP MT940

SAP MT940

SAP MT940

Created Date/Time
0971172017 11:09 AM
10/04/2017 9:17 AM
08/07/2017 3:57 AM
08/07/2017 10:11 AM
06/26/2017 12:00 PM
03/22/2017 8:51 AM
02/28/2018 11:17 AM
06/27/2013 2:39 PM
02/27/2018 11:44 AM
10/112/2017 11:55 AM

(Selected ltems: 1)

Created By
KOSTECKIZ, TOMASZ
TARNOWSKA, HALINA
GUTEK, RADOSLAW
GUTEK, RADOSLAW
SZTUDER, PRZEMYSLAW
GORA, MARCIN
KUCHARSKA, KAROLINA
KOSTRUBIEC, MIROSLAW
KUCHARSKA, KAROLINA
SZTUDER1, PRZEMYSLAW

(As of DTHMTI2018, 12:46) (¥

[ save As 5 Print

(As of 0711712018, 12:48) @ &b

Last Modified Date/Time

10/04/2017 9:20 AM

D6/26/2017 12:16 PM

Authorization is the last step of the profile creation stage. Once the authorization is complete, the profile is Active and may be used

to generate statements.
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3. Initiating Export

In order to run exporting transactions to file, place the cursor on the tab File Services in the top menu, and next choose the option

To Run under the section Export Data.

citr

Home CitiDirect Services Payments

Reports & Inquiries &
Analytics Searches

Client Logged in as: DEMO POLAND 0 failed attempts since last login 07/17/2018 10:16:21

GDFR - important information

My Favorites

—

<C Co. LTD Payrol ¥

From 15.08 CifiDirect BE require TLS 1.2 pr

Now you can add your links as your favorites.
Add your page as favorite by clicking the star icon

[} saveas g Print

Required Field

Payments Pending Action -

File Services

Self Senice

Export File Template

View All

To Submit/Modify/Repair
To Authorize

Create Template

..Import File Template Schedule Files and Reports

To Submit/Modify/Repair View All
To Authorize To Submit/Modify/Repair
Create Template To Authorize

Create Schedule

Import T
Export Data WView All Additional Services
View All To Test Document Services
To Run To Authorize

To Run History

Export Custom Format
View All

To Submit/Modify
Create Custom Format

Import File Template
View All

To Run
To Run History

SIMIME
View All
To Submit/Modify
Create Certificate

Click here to customize your shortcuts

Reports Manager =]

CitiDirect BE®

omize Homepage

>

A list of available export templates will appear. Choose the one which you wish to use, and next click Run. If you are unsure, which
template you should use, it is possible to check the details of templates by clicking on View Details.

CitiDirect Services Payments

Reports & Inquiries &
Analytics Searches

File Services

Self Service

CitiDirect BE®

Client Logged in as: DEMO POLAND 0 failed attempts since last login 0717/2018 11:37:17

File Services + Export Data + To Run

Export Data: To Run

View All To Run

LY | view petans

To Run (1-9 of 9)

| Template Name 1.4
] 001 mig40 Active
O 123 Active
] CRC Active
[ INTRA Active
[ INTRA2 Active
ON Active
[ Test Active
[] testtransakcje Active
[ tests Active

To Run History

Show Applied Search Criteria

Qutput Format Name

SAP MT940

BAI2Z

SAP MTO40
TESTPS

SWIFT MTa40

BAI2

BAI1

TEST TRANSAKCJA
SWIFT MT940

Created Date/Time

D4/06/2013 3:46 PM
07172018 12119 PM
06/04/2013 12:03 PM
04/19/2018 10:53 AM
04/19/2013 10:57 AM
0711712018 1214 PM
07/11/2018 3:08 PM
03/29/2018 9:18 AM
05/07/2018 10:42 AM

B save As B Print

(Selected ltems: 1) (As of 07/17/2018, 1321) &, &G

Created By
ROGULSKI, KAROL
TRZECIAK, NATALIA
MICHNA, JAKUB
SZTUDER1, PRZEMYSLAW
SZTUDER1, PRZEMYSLAW
TRZECIAK, NATALIA
TRZECIAK, NATALIA
SZTUDER1, PRZEMYSLAW
KUREK, TOMASZ

03/28/2018 9:36 AM
07/13/2018 2:00 PM

Last Modified Date/Time

SZTU
WITK
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The profile initiation message will show. Click on OK.
Go to the To Run History tab. You will see the one-row statement that confirms that the report is generated.

Run Status should be completed. If it is not, press the Update Screen button - which is located on the right side of the panel above
the list of To Run history.

The Run status should change within a few seconds.
The Run Status may change to Errors. The most frequent reasons are:

+ Lack of access to the accounts defined in the export profile criteria,
+ No operations on the selected accounts were carried out in the period defined in the import profile.

CitiDirect BE®

e . Trade / Reporis & Inquiries & S e Can
CitiDirect Services Payments eForms Analylics Searches File Services Self Service

Client Logged in as: DEMO POLAND 0 failed attempts since last login 07/18/2018 10:03:45

File Services » Export Data » To Run History

B} save As 5 Print

Export Data: To Run History

View All To Run To Run History

Show Applied Search Criteria

To Run History (1 - 9 of 9) (As of 07/1812018, 11:29) & &G
Run 1D Template Name Run Status Run Date/Time 1v Last Downloaded DatefTime Last Downloaded By 1
® 159204330 Test Completed D7/7/2018 2:47 PM cA
O 159204320 123 Completed D7/17/2018 2:47 PM cA
O 150204328 CRC Errors D7/17/2013 2:47 PM ca
O 159204327 INTRA Errors D77/2018 2:47 PM cA
O 159204328 INTRA2 Errors D7/17/2013 2:47 PM ca
O 159204325 N Downloaded D77/2018 2:47 PM D7M7I2018 2:47 PM TRZECIAK, NATALIA 1502
O 159204324 test transakeje Completed D7/17/2013 2:47 PM ca
O 159200041 001 mt240 Errors D7/17/2018 1:31 PM cA
O 159200039 001 mt240 Errors D7/17/2018 1:21 PM c
< >

In order to download a statement, click on Download. The standard save-file dialogue will open. The file location and name will be
recommended in accordance with the settings in the export profile. The user may select a different location and change the file name
before it is saved.
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4. Creating a Customized Export Format

If the embedded formats (SWIFT MT940 or SAP MT940) are not appropriate for your financial and accounting system, you may

define your own statement format.

On the top menu place the cursor over File Services and choose the option Create Custom Format under the section Export

Custom Format.

atr

Trade /
eForms

Reports &
Analytics

Inquiries &

Home CitiDirect Services Payments Searches

Client Logged in as. DEMO POLAND 0 failed attempts since last login 07/17/2018 11:37.17

From 15.08 CitiDirect BE require TLS 1.2 pn

GDPR - important information

My Favorites

' |

4 Co. LTD Payrol ¥

Now you can add your links as your favorites.
Add your page as favorite by clicking the star icon.

[} save A g Print

Required Field

Payments Pending Action

Reports Manager

File Services

Self Service

Export File Template
View All

...Import File Template
To Submit/Modify/Repair

To Submit/Modify/Repair To Authorize
To Authorize Create Template
Create Template
Import Ti ti
Export Data View All
Wiew All To Test
To Run To Authorize
To Run History To Run

Export Custom Format
View All
To Submit/Modify

Create Custom Format

Import File Template
View All

To Run History

SIMIME
View All
To Submit/Modify
Create Certificate

Schedule Files and Reports
View All

To Submit/Modify/Repair

To Authorize

Create Schedule

Additional Services
Document Services &

Click here to customize your shortcuts

CitiDirect BE®

omize Homepage

>

The screen will display the screen shown below. Enter a Format Name, and choose a Business Service (shows as Payments by default).

CitiDirect Services Eomrame Trade / Reports & Inguiries &

File Services

Self Service

CitiDirect BE®

eForms Analytics Searches

Client Logged in as: DEMO POLAND 0 failed attempts since last login 07/17/2018 14:29:41
File Services + Export Custom Format » Create Custom Format

Export Custom Format: Create Custom Format

Element Definition

# Format Name # Business Service
| | Payments - Statement Data

|

Qutput Layout (Please Select a type to proceed)

Select Any

[* Qutput Layout Type

)

10

* = Required Field

#* = Required Field
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In the field Output Layout Type, select one of the options::

» Tagged - with a defined tag before each field.

+ Fixed Length - all fields of the same length.

« Variable Length - fields have different lengths, depending on data length.

A new screen will be displayed with export format details:

CitiDirect BE®

Trade / Reports & Inguiries &

CitiDirect Services Payments eForms Analytics Searches

File Services

n as DEMO POLAND 0 failed attempts since last login 07/17/2018 14:29:41

File Services » Export Custom Format » Greate Gustom Format

Export Custom Format: Create Custom Format

Element Definition * = Required Field
# Format Name # Business Service

Test | | Payments - Statement Data |

Output Layout (Please Select a type to proceed) * = Required Field

# Output Layout Type

| Fixed Length |

Format Description

Available Data (1 - 233 of 233) h Added Data
| Element Name Type Length | Element Name Type Length Edit
[[] Account Name VARCHAR2 35 A No records
[] Account Number VARCHAR2 35 < >
[ Account Type VARCHARZ2 10
[] Actual Settlement Date DATE 12
[ Additional Requisite VARCHAR2 a7
[1 Amount Bought NUMBER 22
[] Amount Sold NUMBER 22
[1 Applicant Bill Reference VARCHARZ 18
[] Applicant LC Reference VARCHARZ 16
[] Asset Type VARCHAR2 10
[ BL Commission Amount NUMBER 22
< >

The Available Data window contains a list of all the fields which can be added to your personalized format. Select the appropriate
field, and next press the arrow symbol on the right. The selected field will be moved over to the right window Added Data.

In the Added Data window the fields will arrange themselves in the order in which they were added, and the same order will follow in
the exported file. You may change the order with the use of the buttons on the right side.

The table below includes the fields that are most frequently used:

LP Field title Type Number of characters Field Description
1 NULL NULL 5 Blank Field
2 BRANCH NAME AN 105 BRANCH NAME (WARSAW CITIBANK)
3 BRANCH CODE AN 5 BARNCH CODE
4 ACCOUNT NAME AN 35 ACCOUNT NAME
5 ACCOUNT NUMBER AN 35 ACCOUNT NUMBER
6 STATEMENT DATE DATA 12 STATEMENT DATE
7 OPENING LEDGER BALANCE N 22 OPENING LEDGER BALANCE
8 CLOSING AVAILABLE BALANCE N 22 CLOSING AVAILABLE BALANCE
9 CLOSING LEDGER BALANCE N 22 CLOSING LEDGER BALANCE
10 TRANSACTION POST DATE DATA 12 TRANSACTION POST DATE
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n VALUE DATE DATA 12 VALUE DATE

12 CUSTOMER REFERENCE (TRANSACTION REF) | AN 35 CUSTOMER REFERENCE (TRANSACTION REF)
13 BANK REFERENCE AN 16 BANK REFERENCE

14 CURRENCY AN 3 CURRENCY

15 CREDIT/DEBIT INDICATOR A 2 CREDIT/DEBIT INDICATOR

16 TRANSACTION AMOUNT N 22 TRANSACTION AMOUNT

17 TOTAL CREDIT AMOUNT N 22 TOTAL CREDIT AMOUNT

18 TOTAL DEBIT AMOUNT N 22 TOTAL DEBIT AMOUNT

19 BY ORDER OF NAME AN 35 BY ORDER OF NAME

20 PAYMENT DETAILS AN 140 PAYMENT DETAILS

21 TRANSACTION DESCRPTION AN 140 TRANSACTION DESCRIPTION

N- numeric field, AN - alphanumeric field, DATA - date field.

After adding all the information that is to be included in the output field, go to Settings.

Settings % = Required Field
# Credit Currency Format + Debit Currency Format + Digit Grouping Symbol + Record Delimeter
[sPace [v] [o [v] | | @ ]
+ Decimal Symbol + Date Format # Time Format # No. of Digits after Decimal
[ [v] [MwoDrenes [ [ Arss v R \
Padding Character Tag Delimiter Mull Value Mo. of Digits in Group
| | o | B |
Block Size Field Delimiter Field Alignment
| | E e

. Submit |

Setup:

Field Delimiter - end of field mark.

Record Delimiter - end of record mark. If you select CRLF in this field, particular records will be displayed in separate lines.
Credit Currency Format - determination of the incoming amount (+, -, space...). \

Debit Currency Format - determination of the charge amount (+, -, space...).

Decimal Symbol - separator between the integer and decimal part.

No. of Digits after Decimal - thousands separator.

Digit Grouping Symbol - symbol of thousands separation

Date Format and Time Format

Having defined the settings, press on Submit.
The export format you have defined will be on the select-from list while creating the export profile.
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